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Abstract 
 

  

These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 12.0 and Avaya 

Session Border Controller Release 10.2 to support WorldNet Telecommunications SIP 

Trunking Service. 

 

The test was performed to verify SIP trunk features including basic calls, call forward (all 

calls, busy, no answer), call transfer (blind and consultative), conference, and voice mail. The 

calls were placed to and from the public switched telephone network (PSTN) with various 

Avaya endpoints. 

 

Readers should pay attention to Section 2, in particular the scope of testing as outlined in 

Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases 

are adequately covered by this scope and results. 

 

Information in these Application Notes has been obtained through DevConnect compliance 

testing and additional technical discussions.  Testing was conducted via the Avaya 

DevConnect Program. 

 

 



 
HG; Reviewed: 

SPOC 10/6/2024 

Avaya DevConnect Application Notes 

©2024 Avaya Inc. All Rights Reserved. 

2 of 118 

WN-IPO120SBC102 

 

Table of Contents 
1. Introduction ............................................................................................................................. 4 

2. General Test Approach and Test Results ................................................................................ 4 

2.1. Interoperability Compliance Testing ................................................................................ 5 

2.2. Test Results ...................................................................................................................... 6 

2.3. Support ............................................................................................................................. 7 

3. Reference Configuration ......................................................................................................... 8 

4. Equipment and Software Validated ...................................................................................... 11 

5. Avaya IP Office Primary Server Configuration .................................................................... 12 

5.1. Licensing ........................................................................................................................ 14 

5.2. System Settings .............................................................................................................. 15 

5.2.1. System - LAN1 Tab ................................................................................................ 15 

5.2.2. System - Telephony Tab ......................................................................................... 19 

5.2.3. System - VoIP Tab .................................................................................................. 20 

5.3. IP Route .......................................................................................................................... 22 

5.4. SIP Line .......................................................................................................................... 23 

5.4.1. Creating a SIP Trunk from an XML Template ....................................................... 23 

5.4.2. SIP Line – SIP Line Tab ......................................................................................... 27 

5.4.3. SIP Line - Transport Tab ........................................................................................ 28 

5.4.4. SIP Line – Call Details Tab .................................................................................... 29 

5.4.5. SIP Line - VoIP Tab ............................................................................................... 30 

5.4.6. SIP Line – SIP Advanced Tab ................................................................................ 31 

5.5. IP Office Line – Primary Server .................................................................................... 32 

5.6. Incoming Call Route ...................................................................................................... 34 

5.7. Outbound Call Routing .................................................................................................. 36 

5.7.1. Short Codes and Automatic Route Selection .......................................................... 36 

5.8. Save IP Office Primary Server Configuration ................................................................ 38 

6. Avaya IP Office Expansion System Configuration .............................................................. 39 

6.1. Physical Hardware .......................................................................................................... 40 

6.2. LAN Settings .................................................................................................................. 41 

6.3. IP Route .......................................................................................................................... 42 

6.4. IP Office Line – IP500 V2 Expansion System ............................................................... 43 

6.5. Short Codes .................................................................................................................... 45 

6.6. Automatic Route Selection – ARS ................................................................................. 46 

6.7. Save IP Office Expansion System Configuration .......................................................... 47 

7. Configure Avaya Session Border Controller ........................................................................ 48 

7.1. Log in Avaya SBC ......................................................................................................... 48 

7.2. Device Management ....................................................................................................... 50 

7.3. TLS Management ........................................................................................................... 52 

7.3.1. Verify TLS Certificates – Avaya Session Border Controller ................................. 52 

7.3.2. Server Profiles ......................................................................................................... 54 

7.3.3. Client Profiles ......................................................................................................... 56 

7.4. Configuration Profiles .................................................................................................... 58 



 
HG; Reviewed: 

SPOC 10/6/2024 

Avaya DevConnect Application Notes 

©2024 Avaya Inc. All Rights Reserved. 

3 of 118 

WN-IPO120SBC102 

 

7.4.1. Server Interworking – Avaya-IPO .......................................................................... 58 

7.4.2. Server Interworking - SP-General .......................................................................... 61 

7.4.3. SIP Server Configuration ........................................................................................ 65 

7.4.4. Routing Profiles ...................................................................................................... 75 

7.4.5. Topology Hiding ..................................................................................................... 80 

7.5. Domain Policies ............................................................................................................. 84 

7.5.1. Application Rules.................................................................................................... 84 

7.5.2. Media Rules ............................................................................................................ 86 

7.5.3. End Point Policy Groups ......................................................................................... 91 

7.6. Network & Flows Settings ............................................................................................. 95 

7.6.1. Network Management ............................................................................................. 95 

7.6.2. Media Interface ....................................................................................................... 97 

7.6.3. Signaling Interface .................................................................................................. 99 

7.6.4. End Point Flows .................................................................................................... 102 

8. WorldNet Telecommunications SIP Trunking Service Configuration ............................... 107 

9. Verification Steps ................................................................................................................ 108 

9.1. IP Office System Status................................................................................................ 108 

9.2. Monitor ......................................................................................................................... 110 

9.3. Avaya Session Border Controller ................................................................................. 111 

10. Conclusion ...................................................................................................................... 117 

11. Additional References ..................................................................................................... 117 

 



 
HG; Reviewed: 

SPOC 10/6/2024 

Avaya DevConnect Application Notes 

©2024 Avaya Inc. All Rights Reserved. 

4 of 118 

WN-IPO120SBC102 

 

1. Introduction 
These Application Notes describe the steps necessary for configuring Session Initiation Protocol 

(SIP) Trunking service between WorldNet Telecommunications and an Avaya SIP-enabled 

enterprise solution. 

 

In the configuration used during the testing, the Avaya SIP-enabled enterprise solution consists 

of an Avaya IP Office Server Edition, two Avaya IP Office 500 V2 as expansion systems, 

running software release 12.0 (hereafter referred to as IP Office), an Avaya Session Border 

Controller Release 10.2 (hereafter referred to as Avaya SBC) and various Avaya endpoints, 

listed in Section 4. 

 

The WorldNet Telecommunications SIP Trunking Service referenced within these Application 

Notes is designed for business customers. Customers using this service with the IP Office 

solution are able to place and receive PSTN calls via a broadband wide area network (WAN) 

connection using the SIP protocol. This converged network solution is an alternative to 

traditional PSTN trunks such as analog and/or ISDN-PRI trunks. This approach generally results 

in lower cost for the enterprise. 

 

The terms “service provider”, “WorldNet Telecommunications” or “WorldNet” will be used 

interchangeably throughout these Application Notes. 

2. General Test Approach and Test Results  
The general test approach was to connect a simulated enterprise site to WorldNet’s network via 

the public Internet, as depicted in Figure 1, and exercise the features and functionalities listed in 

Section 2.1. 

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The 

jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent 

to the interoperability of the tested products and their functionalities. DevConnect Compliance 

Testing is not intended to substitute full product performance or feature testing performed by 

DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or 

completeness of a DevConnect member’s solution. 

 

Avaya recommends our customers implement Avaya solutions using appropriate security and 

encryption capabilities enabled by our products. The testing referenced in this DevConnect 

Application Note included the enablement of supported encryption capabilities in the Avaya 

products. Readers should consult the appropriate Avaya product documentation for further 

information regarding security and encryption capabilities supported by those Avaya products. 

 

Support for these security and encryption capabilities in any non-Avaya solution component is 

the responsibility of each individual vendor. Readers should consult the appropriate vendor-

supplied product documentation for more information regarding those products. 
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For the testing associated with these Application Notes, the interface between Avaya systems 

and WorldNet did not utilize encryption capabilities, UDP/RTP was used. 

2.1. Interoperability Compliance Testing 

To verify SIP trunk interoperability the following features and functionalities were exercised 

during the interoperability compliance test: 

• SIP Trunk Registration (Dynamic Authentication). 

• Response to SIP OPTIONS queries. 

• Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, Digital and 

Analog telephones at the enterprise. All incoming calls from the PSTN were routed to the 

enterprise across the SIP trunk from the service provider’s network. 

• Outgoing PSTN calls from Avaya endpoints, including SIP and H.323, Digital and 

Analog telephones at the enterprise. All outgoing calls to the PSTN were routed from the 

enterprise across the SIP trunk to the service provider’s network. 

• Incoming and outgoing PSTN calls to/from Avaya Workplace Client for Windows (SIP). 

• Caller ID presentation. 

• Proper disconnect when the caller abandons the call before the call is answered. 

• Proper disconnect via normal call termination by the caller or the called parties. 

• Proper disconnect by the network for calls that are not answered (with coverage to 

voicemail off). 

• Proper response to busy endpoints. 

• Proper response/error treatment when dialing invalid PSTN numbers.  

• Proper codec negotiation and two-way speech-path. Testing was performed with codecs: 

G.722 64K and G.711MU, with G.722 64K being the preferred codec. 

• Proper response to no matching codecs. 

• Proper early media transmissions. 

• Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail 

messages, etc.). 

• Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems). 

• Call Hold/Resume (long and short duration). 

• Call Forward (unconditional, busy, no answer).  

• Blind Call Transfers. 

• Consultative Call Transfers. 

• Station Conference. 

• Mobility twinning of incoming calls to mobile phones. 

 

Note: Remote Worker was tested as part of this solution. The configuration necessary to support 

remote workers is beyond the scope of these Application Notes and is not included in these 

Application Notes. 
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Items not supported or not tested included the following: 

• Inbound toll-free calls, 911 calls (emergency), “0” calls (Operator), 0+10 digits calls 

(Operator Assisted) were not tested. 

• T.38 fax: WorldNet doesn’t support T.38 fax, G.711 pass-through is the preferred fax 

method for WorldNet. G.711 pass-through fax was tested successfully. 

2.2.  Test Results 

Interoperability testing of WorldNet Telecommunications SIP Trunking Service was completed 

with successful results for all test cases with the exception of the observations/limitations 

described below. 

• SIP endpoints may indicate that a transfer failed even when it is successful – 

Occasionally on a transfer operation, Avaya IP Office SIP endpoints (Avaya 1100 Series 

Deskphones) may indicate on the local call display that the transfer failed even though it 

was successful. The frequency of this behavior can be reduced by enabling “Emulate 

Notify for REFER” on the IP Office SIP Line (Section 5.4.6). 

• WorldNet does not support REFER for call forward – WorldNet supports REFER for 

call transfers to the PSTN but does not support REFER for call forward to the PSTN. The 

call scenario in which WorldNet does not support REFER is for inbound calls from the 

PSTN to IP Office which are then forwarded to another PSTN endpoint. In this scenario, 

if REFER is enabled (Section 5.4.2), WorldNet responds with a “403 Forbidden” 

message in response to the REFER message sent by IP Office. The “403 Forbidden” 

response does not have any user impact; it’s simply ignored by IP Office (the call does 

not drop). This issue was solved by enabling “No REFER if using Diversion” on the IP 

Office SIP Line, which resulted in IP Office sending REFER during call transfers to the 

PSTN and not sending  REFER during call forwards to the PSTN (Section 5.4.6.). 

• 481 Call/Transaction Does Not exist/405 Method Not Allowed – After a call from the 

PSTN to the enterprise is successfully transferred to another PSTN party using the SIP 

REFER method, WorldNet accepted the SIP REFER messages sent by IP Office with 

“202 Accepted”, which resulted in SIP trunk resources being released with BYE 

messages, as expected. During the process of releasing the trunk resources, after the 

acceptance of the SIP REFER message, it was observed that WorldNet sent a “BYE” 

followed by a “reINVITE”, which resulted in the Avaya SBC responding with “481 

Call/Transaction Does Not Exist” and “405 Method Not Allowed”. This behaviour had 

no negative impact on the transferred call, SIP trunk resources were released successfully 

after the call transfer. It is being mentioned here simply as an observation. 

• One-Way audio during outbound calls from Avaya Workplace Client for Windows 

softphone (SIP) to the PSTN – One-way audio was observed on calls originated from 

Avaya Workplace Client for Windows softphone (SIP) to the PSTN, there was no audio 

from Workplace to the PSTN, good audio from the PSTN to Workplace. The issue was 

observed only when Media Security under System → VoIP → VoIP Security tab was 

enabled in IP Office (e.g., set to “Preferred”), when set to “Disabled” audio was good in 

both directions. This issue is under investigation by Avaya. As a temporary work around, 

if TLS/SRTP is being used in IP Office, set  Media Security under System → VoIP → 

VoIP Security tab in IP Office to Disabled (refer to Section 5.2.3.2). 
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2.3. Support 

For support on WorldNet Telecommunications systems visit the corporate Web page at: 

https://www.worldnetpr.com/en/voice-service/ 

 

Avaya customers may obtain documentation and support for Avaya products by visiting 

http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292) 

provides access to overall sales and service support menus. 

https://www.worldnetpr.com/en/voice-service/
http://support.avaya.com/
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3. Reference Configuration 
Figure 1 illustrates the test configuration used for the DevConnect compliance test. The test 

configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution 

connected to the WorldNet Telecommunications SIP Trunking Service through the public 

Internet. 

 

The Avaya components used to create the simulated enterprise customer site includes: 

• IP Office Server Edition running in VMware environment. 

− Avaya IP Office Voicemail Pro. 

• Two Avaya IP Office 500 V2 as expansion systems. 

• Avaya Session Border Controller. 

• Avaya J179 IP Deskphones (H.323). 

• Avaya 1100 Series IP Deskphones (SIP). 

• Avaya J129 IP Deskphones (SIP). 

• Avaya 1400 Series Digital Deskphones. 

• Analog Deskphones. 

• Avaya Workplace Client for Windows (SIP). 

 

Avaya IP Office provides the voice communications services for the enterprise. In the reference 

configuration, Avaya IP Office runs on the Avaya IP Office Server Edition platform. Note that 

this solution is extensible to deployments using the standalone IP500 V2 platform as well. 

 

In the sample configuration, the Primary server runs the Avaya IP Office Server Edition Linux 

software. Avaya Voicemail Pro runs as a service on the Primary Server. The LAN1 port of the 

Primary Server is connected to the enterprise LAN. The LAN2 port was not used. 

 

The Expansion Systems (IP500 V2) were used for the support of digital, analog and additional IP 

stations. The Avaya IP Office 500 V2 is equipped with analog and digital extension expansion 

modules, as well as a VCM64 (Voice Compression Module). The LAN1 ports of the Avaya IP 

Office IP500 V2 systems are connected to the enterprise LAN, the LAN2 ports were not used.  

 

Located at the edge of the enterprise is the Avaya SBC. The Avaya SBC has two physical 

interfaces, interface B1 is used to connect to the public network, interface A1 is used to connect 

to the private network. All SIP and RTP traffic entering or leaving the enterprise flows through 

the Avaya SBC. The Avaya SBC provides network address translation at both the IP and SIP 

layers. 

 

IP endpoints at the enterprise included Avaya 1100 Series IP Deskphones (with SIP firmware), 

Avaya J100 Series IP Deskphones (with SIP and H.323 firmware), Avaya Workplace Client for 

Windows (SIP), Avaya Digital and Analog Deskphones. IP endpoints were registered to the 

Primary Server; non-IP endpoints (analog and digital) were registered to the Expansion Systems. 

The site also has a Windows PC running Avaya IP Office Manager to configure and administer 

the system. Mobile Twinning is configured for some of the IP Office users so that calls to these 

user’s extensions will also ring and can be answered at the configured mobile phones.  
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The transport protocol between the Avaya SBC and WorldNet Telecommunications, across the 

public Internet, is SIP over UDP. The transport protocol between the Avaya SBC and IP Office, 

across the enterprise private IP network, is SIP over TLS. 

 

For inbound calls, the calls flowed from WorldNet Telecommunications network to the Avaya 

SBC, then to IP Office.  

 

Outbound calls to the PSTN were first processed by IP Office. Once IP Office selected the 

proper SIP trunk, the call was routed to the Avaya SBC for egress to WorldNet 

Telecommunications network. 

 

For the compliance test, users dialed a short code of 9 + N digits to make calls across the SIP 

trunk to WorldNet Telecommunications network. The short code 9 was stripped off by Avaya IP 

Office, but the remaining N digits were sent unaltered to WorldNet Telecommunications 

network. 

 

In an actual customer configuration, the enterprise site may include additional network 

components between the service provider and the IP Office system, such as a session border 

controller or data firewall. A complete discussion of the configuration of these devices is beyond 

the scope of these Application Notes. However, it should be noted that all SIP and RTP traffic 

between the service provider and the IP Office system must be allowed to pass through these 

devices. 

 

For confidentiality and privacy purposes, public IP addresses and routable DID numbers used 

during the compliance testing have been masked. 
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Figure 1: Avaya Interoperability Test Lab Configuration 
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4. Equipment and Software Validated 
The following equipment and software were used for the sample configuration provided: 

 

Equipment/Software Release/Version 

Avaya 

Avaya IP Office Server Edition (Primary Server) 

• Avaya IP Office Voicemail Pro 

12.0.0.0 Build 55 

12.0.0.0 Build 14 

Avaya IP Office IP500 V2 (Expansion Systems) 12.0.0.0 Build 55 

Avaya IP Office Manager 12.0.0.0 Build 55 

Avaya Session Border Controller ASBC 10.2.0.0-86-24077 

Avaya J179 IP Telephone (H.323) Version 6.8.5.5.1 

Avaya 1140E IP Deskphones (SIP) SIP1140e Ver. 04.04.23.00 

Avaya J129 IP Deskphones (SIP) Version 4.0.10.3.2 

Avaya 1408 Digital Telephone 48.02 

Avaya Workplace Client for Windows (SIP). 3.36.0.137 

Analog Telephone --- 

WorldNet Telecommunications 

Metaswitch CFS: V9.3.20 

Oracle SBC Acme Packet 4600 SCZ8.1.0 GA  

(Build 33) 

 

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone 

IP Office 500 V2 and also when deployed with all configurations of IP Office Server Edition. IP 

Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital 

endpoints. 
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5. Avaya IP Office Primary Server Configuration 
Avaya IP Office is configured through the Avaya IP Office Manager application. From the PC 

running the IP Office Manager application, select Start → Programs → IP Office → Manager 

to launch the Manager application. Log in using the appropriate credentials. 
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On Server Edition systems, the Solution View screen will appear, similar to the one shown 

below. All the Avaya IP Office configurable components are shown in the left pane, known as 

the Navigation Pane. Clicking the “plus” sign next to the Primary server system name, e.g., 

IPOSE-Primary, on the navigation pane will expand the menu on this server. 
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In the screens presented in the following sections, the View menu was configured to show the 

Navigation pane on the left side and the Details pane on the right side. These panes will be 

referenced throughout the rest of this document.  

 

Standard feature configurations that are not directly related to the interfacing with the service 

provider are assumed to be already in place, and they are not part of these Application Notes. 

5.1. Licensing  

The configuration and features described in these Application Notes require the IP Office system 

to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, 

contact an authorized Avaya sales representative. 

 

In the reference configuration, IPOSE-Primary was used as the system name of the Primary 

Server, IP500V2-One and IP500V2-Two were used as the system name for the two Expansion 

Systems. All navigation described in the following sections (e.g., License) appears as submenus 

underneath the system name in the Navigation Pane.  

 

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status 

for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the 

number of channels provisioned for the SIP trunk. 
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5.2. System Settings  

Configure the necessary system settings. In an Avaya IP Office, the LAN2 tab settings 

correspond to the Avaya IP Office WAN port (public network side) and the LAN1 tab settings 

correspond to the LAN port (private network side). For the compliance test, the LAN1 interface 

was used to connect IP Office to the enterprise private network (LAN), LAN2 was not used. 

5.2.1. System - LAN1 Tab 

In the sample configuration, IPOSE-Primary was used as the system name, the LAN1 port 

connects to the inside interface (enterprise private network side) of the Avaya SBC across the 

enterprise LAN (private) network. The outside interface of the Avaya SBC connects to WorldNet 

Telecommunications network via the public internet. To access the LAN1 settings, navigate to 

System (1) → IPOSE-Primary in the Navigation Pane. 

5.2.1.1 LAN1 LAN Settings tab 

The LAN Settings tab as shown in the screenshot below was configured with following settings: 

• Set the IP Address field to the LAN IP address, e.g., 10.64.101.127. 

• Set the IP Mask field to the subnet mask of the enterprise private network, e.g., 

255.255.255.0. 

• All other parameters should be set according to customer requirements. 

• Click OK to commit. 
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5.2.1.2 LAN1 VoIP Tab 

The VoIP tab as shown in the screenshot below was configured with following settings: 

• Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the 

H.323 protocol to register. 

• Select Preferred under H.323 Signaling over TLS. When enabled, TLS is used to 

secure the registration and call signaling communication between IP Office and endpoints 

that support TLS. The H.323 phones that support TLS are 9608, 9611, 9621, 9641 

running firmware version 6.6 or higher and the Avaya J100 Series IP Deskphones. 

• Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to 

WorldNet Telecommunications. 

• Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register 

using the SIP protocol. 

• Enter the Domain Name of the enterprise under SIP Domain Name. 

• Enter the SIP Registrar FQDN of the enterprise under SIP Registrar FQDN. 

• Check TLS and verify the TLS Port numbers under Layer 4 Protocol are set to 5061. 
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Scroll down the page: 

• Verify the RTP Port Number Range settings for a specific range for the RTP traffic. 

The Port Range (Minimum) and Port Range (Maximum) values were kept as default. 

• In the Keepalives section at the bottom of the page, set the Scope field to RTP-RTCP, 

Periodic Timeout to 30, and Initial keepalives to Enabled. This will cause the IP Office 

to send RTP and RTCP keepalive packets at the beginning of the calls and every 30 

seconds thereafter if no other RTP/RTCP traffic is present.  

• All other parameters should be set according to customer requirements. 

• Click OK to commit. 
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5.2.1.3 LAN1 Network Topology tab 

The Network Topology tab as shown in the screenshot below was configured with following 

settings: 

• The Firewall/NAT Type was set to Open Internet in the reference configuration.  

• The Binding Refresh Time (sec) was set to 60 seconds. This is used to determine the 

frequency at which Avaya IP Office will send SIP OPTIONS messages, to periodically 

check the status of the SIP lines configured on this interface.  

• The Public IP Address and Public Port sections are not used. 

• Click OK to commit. 
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5.2.2. System - Telephony Tab 

To access the System Telephony settings, navigate to the Telephony → Telephony tab in the 

Details pane, configure the following parameters:  

• Choose the Companding Law typical for the enterprise location; U-Law was used for 

the compliance test. 

• Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and 

call transfer to the PSTN. If for security reasons incoming calls should not be allowed to 

transfer back to the PSTN then leave this setting checked.  

• All other parameters should be set to default or according to customer requirements.  

• Click OK to commit. 
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5.2.3. System - VoIP Tab 

Navigate to the VoIP tab in the Details pane to view or change the system codecs and VoIP 

security settings. 

5.2.3.1 VoIP - VoIP Tab 

Select the VoIP → VoIP tab, configure the following parameters: 

• The RFC2833 Default Payload field allows for the manual configuration of the payload 

type used on SIP calls that are initiated by the IP Office. The default value 101 was used. 

• For codec selection, select the codecs and codec order of preference on the right, under 

the Selected column. The Default Codec Selection area enables the codec preference 

order to be configured on a system-wide basis. The buttons between the two lists can be 

used to move codecs between the Unused and Selected lists, and to change the order of 

the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323) 

will use the system codec selection shown here, unless configured otherwise for a 

specific line or extension. The example below shows the codecs used for IP phones (SIP 

and H.323). Testing was performed with codecs G.722 and G.711MU as requested by 

WorldNet, with G.722 being the preferred codec. 

• Click OK to commit. 

 

 
 

Note: The codec selections defined under this section (VoIP – VoIP tab) are the codecs selected 

for the IP phones/extensions. The codec selections defined under Section 5.4.5 (SIP Line – VoIP 

tab) are the codecs selected for the SIP Line (Trunk). 
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5.2.3.2 VoIP – VoIP Security Tab 

Secure Real-Time Transport Protocol (SRTP) refers to the application of additional encryption 

and or authentication to VoIP calls (SIP and H.323). SRTP can be applied between telephones, 

between ends of an IP trunk or in various other combinations. 

 

Configuring the use of SRTP at the system level is done on the VoIP Security tab using the 

Media Security setting. The options are: 

• Disabled (default). 

• Preferred. 

• Enforced. 

 

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP 

Office uses SRTP if supported by the far-end, otherwise uses RTP. If the Enforced setting is 

used, and SRTP is not supported by the far-end, the call is not established (refer to Section 2.2 

for one-way audio issue involving Avaya Workplace client for Windows softphones). 

 

To configure the use of SRTP, select the VoIP → VoIP Security tab on the Details pane.  

• Set the Media Security drop-down menu to Preferred to have IP Office attempt use 

encrypted RTP for devices that support it and fall back to RTP for devices that do not 

support encryption.  

• Verify Strict SIPS is not checked. 

• Under Media Security Options, select RTP for the Encryptions and Authentication 

fields.  

• Under Crypto Suites, select SRTP_AES_CM_128_SHA1_80.  

• Click OK to commit. 
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5.3. IP Route 

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to 

send the packets in order to route calls to WorldNet Telecommunications network.  

 

Navigate to IP Route, right-click on IP Route and select New. The values used during the 

compliance test are shown below: 

• Set the IP Address and IP Mask to 0.0.0.0 to make this the default route. 

• Set Gateway IP Address to the IP address of the gateway/router used to route calls to the 

public network, e.g., 10.64.101.1. 

• Set Destination to LAN1 from the pull-down menu. 

• Click OK to commit. 
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5.4. SIP Line  

A SIP line is needed to establish the SIP connection between Avaya IP Office and WorldNet 

Telecommunications. The recommended method for configuring a SIP Line is to use the 

template associated with these Application Notes. The template is an .xml file that can be used 

by IP Office Manager to create a SIP Line. Follow the steps in Sections 5.4.1 to create the SIP 

Line from the template. 

 

Some items relevant to a specific customer environment are not included in the template or may 

need to be updated after the SIP Line is created. Examples include the following: 

• IP addresses 

• SIP Credentials (if applicable) 

• SIP URI entries 

 

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary 

after the SIP Line is created via the template. The resulting SIP Line data can be verified against 

the manual configuration shown in Section 5.4.2 to 5.4.6. 

 

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the 

Navigation pane and select New → SIP Line. Then, follow the steps outlined in Sections 5.4.2 

to 5.4.6. 

5.4.1. Creating a SIP Trunk from an XML Template 

DevConnect generated SIP Line templates are always exported in an XML format. These XML 

templates do not include sensitive customer specific information and are therefore suitable for 

distribution. The XML format templates can be used to create SIP trunks on both IP Office 

Standard Edition (500 V2) and IP Office Server Edition systems. Alternatively, binary templates 

may be generated. However, binary templates include all the configuration parameters of the 

Trunk, including sensitive customer specific information. Therefore, binary templates should 

only be used for cloning trunks within a specific customer’s environment. 

 

Copy a previously created template file to a location (e.g., \Temp) on the same computer where 

IP Office Manager is installed.  
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To create the SIP Trunk from the template, from the Primary server, right-click on Line in the 

Navigation Pane, then navigate to New → New from Template→Open from file. 
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Navigate to the directory on the local machine where the template was copied and select the 

template. 

 

 
 

After the import is complete, a final import status pop-up window will open stating success or 

failure. Click OK. 
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The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17). 

 

 
 

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP 

Line is created via the template. The resulting SIP Line data can be verified against the manual 

configuration shown in Sections 5.4.2 to 5.4.6. 
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5.4.2. SIP Line – SIP Line Tab 

On the SIP Line tab in the Details pane, configure or verify the parameters as shown below: 

• Leave the ITSP Domain Name blank. Note that if this field is left blank, then IP Office 

inserts the ITSP Proxy Address from the Transport tab as the ITSP Domain in the SIP 

messaging. 

• Local Domain Name is set to the IP address of the Avaya IP Office LAN1 interface 

(e.g., 10.64.101.127). 

• Verify that In Service box is checked, the default value. This makes the trunk available 

to incoming and outgoing calls. 

• Verify that Check OOS box is checked, the default value. IP Office will use the SIP 

OPTIONS method to periodically check the SIP Line. 

• Verify that Refresh Method is set to Auto. 

• Verify that Timer (sec) is set to On Demand. 

• Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing 

Supervised REFER to Always. 

• Click OK to commit. 
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5.4.3. SIP Line - Transport Tab 

Select the Transport tab. Set or verify the parameters as shown below: 

• Set the ITSP Proxy Address to the inside IP Address of the Avaya SBC or 

10.64.101.243 as shown in Figure 1. 

• Set Layer 4 Protocol to TLS. 

• Set Use Network Topology Info to None (see note below).  

• Set the Send Port to 5061. 

• Default values may be used for all other parameters. 

• Click OK to commit. 

 

 
 

Note – For the compliance testing, the Use Network Topology Info field was set to None, since 

no NAT was used in the test configuration.  In addition, it was not necessary to configure the 

System → LAN1 → Network Topology tab for the purposes of SIP trunking.  If a NAT is used 

between Avaya IP Office and the other end of the trunk, then the Use Network Topology Info 

field should be set to the LAN interface (LAN1) used by the trunk and the System → LAN1 → 

Network Topology tab needs to be configured with the details of the NAT device. 
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5.4.4. SIP Line – Call Details Tab 

Select the Call Details tab, and then click the Add… button (not shown) and the screen shown 

below will appear. To edit an existing entry, click an entry in the list at the top, and click the 

Edit… button. In the example screen below a new entry was created with the parameters shown 

below:  

• Associate this line with an incoming line group by entering a line group number in the 

Incoming Group field. This line group number will be used in defining incoming call 

routes for this line. Similarly, associate the line to an outgoing line group using the 

Outgoing Group field. The outgoing line group number is used in defining short codes 

for routing outbound traffic to this line. For the compliance test, a new incoming and 

outgoing group 17 was defined that only contains this line (line 17). 

• Under Credentials, select 0: <None> from the pull-down menu. 

• Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP 

URI pattern. 

• Verify P Asserted ID and Diversion Header are checked.  

• Set the Local URI, Contact, P Asserted ID and Diversion Header fields to the values 

shown in the screenshot below. 

• Set all remaining fields as shown on the screenshot below.  

• Click OK. 
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5.4.5. SIP Line - VoIP Tab 

Select the VoIP tab, to set the Voice over Internet Protocol parameters of the SIP Line. Set or 

verify the parameters as shown below: 

• The Codec Selection was configured using the System Default option, allowing the 

same codec order used under System – VoIP (refer to Section 5.2.3.1). Testing was 

performed with codecs G.722 64K and G.711MU, with G.722 64K being the preferred 

codec. 

• Select G.711 for Fax Transport Support (refer to Section 2.1). 

• Set the DTMF Support field to RFC2833/RFC4733. This directs Avaya IP Office to 

send DTMF tones using RTP events messages as defined in RFC2833. 

• Set the Media Security field to Disabled. 

• Check the Re-invite Supported box.  

• Check the PRACK/100rel Supported box. 

• Default values may be used for all other parameters. 

• Click the OK to commit. 

 

 
 

Note: The codec selections defined under this section are the codecs selected for the SIP Line 

(Trunk). The codec selections defined under Section 5.2.3 are the codecs selected for the IP 

phones/extension (H.323 and SIP). 
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5.4.6. SIP Line – SIP Advanced Tab 

In the Addressing area: 

• Select To Header for Call Routing Method. 

 

In the Identity area: 

• Check the box for Use PAI for Privacy. 

• Under Call Control, check Emulate NOTIFY for REFER and No REFER if using 

Diversion (refer to Section 2.2). 

• Default values may be used for all other parameters. 

• Click OK to commit. 
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5.5. IP Office Line – Primary Server 

In IP Office Server Edition systems, IP Office Lines are automatically created on each server 

when a Secondary server or Expansion System is added to the solution. To edit an existing IP 

Office Line, select Line in the Navigation pane, and select the appropriate line to be configured 

in the Group pane. The screen below shows the IP Office Line to the IP500V2-One Expansion 

System. 
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The screen below shows the IP Office Line, VoIP Settings tab:  

• The Codec Selection was configured using the Custom option, allowing an explicit 

order of codecs to be specified for the SIP Line. The buttons allow setting the specific 

order of preference for the codecs to be used on the SIP Line, as shown. Only codec 

G.711ULAW 64K was selected for the IP500V2 expansion systems (G.722 64K was not 

included), this was required in order for G.711 pass-through fax to work properly. 

• Select G.711 for Fax Transport Support (refer to Section 2.1). 

• Under Media Security verify Same as System (Preferred) is selected (default value). 

• On the Advanced Media Security Options check Same As System. 

 

 
 

Repeat this process as needed to add additional Secondary server or Expansion Systems to the 

solution. 
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5.6. Incoming Call Route 

Incoming call routes map inbound DID numbers on a specific line to internal extensions, hunt 

groups, short codes, etc., within the IP Office system. To add an incoming call route, right click 

on Incoming Call Route in the Navigation pane and select New (not shown). On the Details 

Pane, under the Standard tab, set the parameters as show below: 

• Set Bearer Capacity to Any Voice.  

• The Line Group ID is set to 17. This matches the Incoming Group field configured in 

the Call Details tab for the SIP Line on Section 5.4.4. 

• On the Incoming Number, enter one of the DID numbers provided by WorldNet. 

• Default values may be used for all other parameters. 

• Click OK to commit (not shown). 

 

 
 



 
HG; Reviewed: 

SPOC 10/6/2024 

Avaya DevConnect Application Notes 

©2024 Avaya Inc. All Rights Reserved. 

35 of 118 

WN-IPO120SBC102 

 

Select the Destinations tab. From the Destination drop-down menu, select the IP Office 

extension associated with this DID number. In the reference configuration, the DID number 

7879578057 provided by WorldNet was associated with the Avaya IP Office extension 3042. 

 

 
 

Repeat this process as needed to assign incoming call routes to additional IP Office users, as well 

as for other Avaya IP Office destinations (Hunt Group, Voicemail, Short Codes, etc.). 
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5.7. Outbound Call Routing 

For outbound call routing, a combination of system short codes and Automatic Route Selection 

(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing 

can be specified so that a call can re-route automatically if the primary route or outgoing line 

group is not available. While detailed coverage of ARS is beyond the scope of these Application 

Notes, and alternate routing was not used in the reference configuration, this section includes 

some basic screen illustrations of the ARS settings used during the compliance testing. 

5.7.1. Short Codes and Automatic Route Selection 

To create a short code to be used for ARS, right-click on Short Code, the Navigation pane and 

select New. The screen below shows the short code 9N created (note that the semi-colon is not 

used here). In this case, when the IP Office user dials 9 plus any number N, instead of being 

directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is 

configurable via ARS. 

• In the Code field, enter the dial string which will trigger this short code. In this case, 9N 

was used (note that the semi-colon is not used here). 

• Set Feature to Dial. This is the action that the short code will perform. 

• Set Telephone Number to N. The value N represents the number dialed by the user after 

removing the 9 prefix. This value is passed to ARS. 

• Set the Line Group ID to 50: Main to be directed to Line Group 50: Main, this is 

configurable via ARS. 

• For Locale, United States (US English) was used. 

• Click the OK to commit. 
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The following screen shows the example ARS configuration for the route Main. Note the 

sequence of Xs used in the Code column of the entries to specify the exact number of digits to be 

expected, following the access code and the first set of digits on the string. This type of setting 

results in a much quicker response in the delivery of the call by IP Office. 

 

To create a short code to be used for ARS, select ARS → 50: Main on the Navigation Pane and 

click Add (not shown). Configure the following parameters: 

• In the Code field, enter the dial string which will trigger this short code. In this case, 1 

followed by 10 Xs to represent the exact number of digits. 

• Set Feature to Dial. This is the action that the short code will perform. 

• Set Telephone Number to 1N. The value N represents the additional number of digits 

dialed by the user after dialing 1 (The 9 will be stripped off). 

• Set the Line Group ID to the Line Group number being used for the SIP Line, in this 

case Line Group ID 17 was used. 

• For Locale, United States (US English) was used. 

• Click OK to commit. 

 

The following example shows the dial pattern for calls within Puerto Rico and calls to the United 

States. 

 

 
 

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out 

from IP Office. 
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5.8. Save IP Office Primary Server Configuration 

The provisioning changes made in Avaya IP Office Manager must be applied to the Avaya IP 

Office server in order for the changes to take effect. At the top of the Avaya IP Office Manager 

page, click File → Save Configuration (if that option is grayed out, no changes are pending).  

 

A screen similar to the one below will appear, with either Merge or Reboot automatically 

selected, based on the nature of the configuration changes. The Merge option will save the 

configuration change with no impact to the current system operation. The Reboot option will 

save the configuration and cause the Avaya IP Office server to reboot.  

 

Click OK to execute the save. 
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6. Avaya IP Office Expansion System Configuration 
Navigate to File → Open Configuration (not shown), select the proper Avaya IP Office system 

from the pop-up window, and log in using the appropriate credentials. Clicking the “plus” sign 

next to IP500V2-One on the left navigation pane will expand the menu on this server. 
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6.1. Physical Hardware 

In the sample configuration, the IP500 V2 Expansion System contained a PHONE8 analog card, 

for the support of analog extensions, a DIG DCPx16 V2, for support of digital extensions. Also 

included is a VCM64 (Voice Compression Module). The VCM64 cards provide voice 

compression channels to the control unit. Voice compression channels are needed to support 

VoIP calls, including IP extensions and or IP trunks. 
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6.2. LAN Settings 

In the sample configuration, LAN1 is used to connect the Expansion System to the enterprise 

network. To view or configure the LAN1 IP address, select System on the Navigation pane. 

Select the LAN1 → LAN Settings tab on the Details pane, and enter the following:  

• IP Address: 192.168.8.165 was used in the reference configuration.  

• IP Mask: 255.255.255.0 was used in the reference configuration.  

• Click the OK button (not shown).  

 

 
 

Default values were used on the VoIP and Network Topology tabs (not shown). 
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6.3. IP Route 

To create an IP route for the Expansion system, right-click on IP Route on the left Navigation 

pane. Select New (not shown). 

• Enter 0.0.0.0 on the IP Address and IP Mask fields to make this the default route. 

• Set Gateway IP Address to the IP Address of the default router in the IP Office subnet. 

The default gateway in the reference configuration was 192.168.8.1. 

• Set Destination to LAN1 from the pull-down menu. 
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6.4. IP Office Line – IP500 V2 Expansion System 

In IP Office Server Edition systems, IP Office Lines are automatically created on each server 

when a Secondary server or Expansion System is added to the solution. To edit an existing IP 

Office Line, select Line in the Navigation pane, and select the appropriate line to be configured 

in the Group pane. The screen below shows the IP Office Line to the Primary server. 
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The screen below shows the IP Office Line, VoIP Settings tab:  

• The Codec Selection was configured using the Custom option, allowing an explicit 

order of codecs to be specified for the SIP Line. The buttons allow setting the specific 

order of preference for the codecs to be used on the SIP Line, as shown. Only codec 

G.711ULAW 64K was selected for the IP500V2 expansion systems (G.722 64K was not 

included), this was required in order for G.711 pass-through fax to work properly. 

• Select G.711 for Fax Transport Support (refer to Section 2.1). 

• Under Media Security Preferred was selected. 

• On the Advanced Media Security Options check Same As System. 
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6.5. Short Codes 

Similar to the configuration of the Primary server in Section 5.7, create a Short Code to access 

ARS. In the reference configuration, the Line Group ID is set to the ARS route illustrated in the 

next section. 

 

 



 
HG; Reviewed: 

SPOC 10/6/2024 

Avaya DevConnect Application Notes 

©2024 Avaya Inc. All Rights Reserved. 

46 of 118 

WN-IPO120SBC102 

 

6.6. Automatic Route Selection – ARS 

The following screen shows an example ARS configuration for the route named “To-Primary” 

on the Expansion System. The Telephone Number is set to 9N. The Line Group ID is set to 

“99999” matching the number of the Outgoing Group ID configured on the IP Office Line 17 to 

the Primary server (Section 6.4). 

 

 
 

Repeat the process described in Section 6 on any additional Secondary server or Expansion 

Systems in the solution, as required. 
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6.7. Save IP Office Expansion System Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections. 

 

The following will appear, with either Merge or Reboot selected, based on the nature of the 

configuration changes made since the last save. Note that clicking OK may cause a service 

disruption. Click OK to proceed. 
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7. Configure Avaya Session Border Controller 
This section describes the required configuration of the Avaya SBC to connect to WorldNet 

Telecommunications SIP Trunking Service.  

 

It is assumed that the Avaya SBC was provisioned and is ready to be used; the configuration 

shown here is accomplished using the Avaya SBC web interface. 

 

Note: In the following pages, and for brevity in these Application Notes, not every provisioning 

step will have a screenshot associated with it. Some of the default information in the screenshots 

that follow may have been cut out (not included) for brevity. 

7.1. Log in Avaya SBC 

Use a Web browser to access the Avaya SBC Web interface. Enter https://<ip-addr>/sbc in the 

address field of the web browser, where <ip-addr> is the Avaya SBC management IP address. 

 

Enter the appropriate credentials and click Log In. 
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Once logged in, on the top left of the screen, under Device: select the device being managed, 

Avaya_SBC in the sample configuration.  

 

 
 

The left navigation pane contains the different available menu items used for the configuration of 

the Avaya SBC. Verify that the status of the License State field is OK, indicating that a valid 

license is present. Contact an authorized Avaya sales representative if a license is needed.  
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7.2. Device Management 

To view current system information, select Device Management on the left navigation pane. In 

the reference configuration, the device named Avaya_SBC is shown. The management IP 

address that was configured during installation is blurred out for security reasons; the current 

software version is shown. The management IP address needs to be on a subnet separate from the 

ones used in all other interfaces of the Avaya SBC, segmented from all VoIP traffic. Verify that 

the Status is Commissioned, indicating that the initial installation process of the device has been 

previously completed, as shown on the screen below. 
 

 
 

To view the network configuration assigned to the Avaya SBC, click View on the screen above. 

The System Information window is displayed, containing the current device configuration and 

network settings. 
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The System Information screen shows the Network Configuration, DNS Configuration and 

Management IP(s) information provided during installation and corresponds to Figure 1. The 

Box Type was set to SIP and the Deployment Mode was set to Proxy. Default values were used 

for all other fields. 

 

 
 

The IP addresses in the System Information screen shown above are the ones used for the SIP 

trunk to WorldNet Telecommunications and are the ones relevant to these Application Notes. 

Other IP addresses assigned to the Avaya SBC A1 and B1 interfaces are used to support remote 

workers and other SIP trunks, and they are not discussed in this document. Also note that for 

security purposes, any public IP addresses used during the compliance test have been masked in 

this document. 

 

In the reference configuration, the private interface of the Avaya SBC (10.64.101.243) was used 

to connect to the enterprise network, while its public interface (10.10.80.51) was used to connect 

to the public network. See Figure 1. 

 

On the Dynamic License Allocation area of the System Information, verify that the number of 

Standard Sessions is sufficient to support the desired number of simultaneous SIP calls across 

all SIP trunks at the enterprise. The number of sessions and encryption features are primarily 

controlled by the license file installed. 
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7.3.  TLS Management 

Note: Testing was done with System Manager signed identity certificates. The procedure to 

create and obtain these certificates is outside the scope of these Application Notes. 

 

In the reference configuration, TLS transport is used for the communication between IP Office 

and Avaya SBC. The following procedures show how to create the client and server profiles to 

support the TLS connection. 

7.3.1. Verify TLS Certificates – Avaya Session Border Controller 

Once logged in, on the top left of the screen, under Device: select the device being managed, 

Avaya_SBC in the sample configuration. 
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Step 1 - Select TLS Management → Certificates from the left-hand menu. Verify the 

following: 

• Verify the System Manager Root CA certificate is present in the Installed CA 

Certificates area, this certificate is required to enable TLS encryption inside of the 

enterprise (private network side). This Root CA certificate needs to be manually 

downloaded from System Manager and installed in the Avaya SBC; this Root CA 

certificate doesn’t come pre-loaded in the Avaya SBC. Certificates from a 3rd party 

trusted Certificate Authority (CA) could be used for TLS encryption inside of the 

enterprise (private network side) instead of using Avaya System Manager as the 

Certificate Authority. 

• Verify the identity certificate signed by the System Manager CA is present in the 

Installed Certificates area. 

• Verify the Private key associated with the identity certificate signed by the System 

Manager CA is present in the Installed Keys area (not shown). 
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7.3.2. Server Profiles 

Step 1 - Select TLS Management → Server Profiles and click on Add. Enter the following: 

• Profile Name: enter descriptive name, e.g., IPO_12_0_Server_Profile. 

• Certificate: select the identity certificate, e.g., IPOSE_12_0.pem, from pull down menu 

• Peer Verification = None. 

• Click Next. 

Step 2 - Accept default values for the next screen (not shown) and click Finish. 
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The following screen shows the completed TLS Server Profile form: 
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7.3.3. Client Profiles 

Step 1 - Select TLS Management → Client Profiles and click on Add. Enter the following: 

• Profile Name: enter descriptive name, e.g., IPO_12_0_Client_Profile. 

• Certificate: select the identity certificate, e.g., IPOSE_12_0.pem, from pull down menu. 

• Peer Verification = Required. 

• Peer Certificate Authorities: select the CA certificate used to verify the certificate 

received from Session Manager, e.g., Thornton_SMGR_ROOT_CA.pem. 

• Verification Depth: enter 1. 

• Click Next. 

Step 2 - Accept default values for the next screen (not shown) and click Finish. 
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The following screen shows the completed TLS Client Profile form: 
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7.4. Configuration Profiles 

The Configuration Profiles Menu, on the left navigation pane, allows the configuration of 

parameters across all Avaya SBC appliances. 

7.4.1. Server Interworking – Avaya-IPO 

Interworking Profile features are configured to facilitate interoperability of implementations 

between enterprise SIP-enabled solutions and different SIP trunk service providers. 

 

Several profiles have been already pre-defined and they populate the list under Interworking 

Profiles on the screen below. If a different profile is needed, a new Interworking Profile can be 

created, or an existing default profile can be modified or “cloned”. Since directly modifying a 

default profile is generally not recommended, for the test configuration the default avaya-ru 

profile was duplicated, or “cloned”. If needed, the profile can then be modified to meet specific 

requirements for the enterprise SIP-enabled solution. For WorldNet Telecommunications, this 

profile was left with the avaya-ru default values. 

 

On the left navigation pane, select Configuration Profiles → Server Interworking. From the 

Interworking Profiles list, select avaya-ru. Click Clone on top right of the screen (not shown). 

 

Enter the new profile name in the Clone Name field, the name of Avaya-IPO was chosen in this 

example. Click Finish. 
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The following screen capture shows the General tab of the newly created Avaya-IPO Server 

Interworking Profile. 
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The following screen capture shows the Advanced tab of the newly created Avaya-IPO Server 

Interworking Profile. 
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7.4.2. Server Interworking - SP-General 

A second Server Interworking profile named SP-General was created for the Service Provider. 

 

On the left navigation pane, select Configuration Profiles → Server Interworking (not 

shown). From the Interworking Profiles list, select Add (not shown) (note that Add is being 

used to create the SP-General profile instead of cloning the avaya-ru profile). 

 

Enter the new profile name, the name of SP-General was chosen in this example. 

• Click Next. 
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On the General tab, click Next until the last tab is reached then click Finish on the last tab 

leaving remaining fields with default values (not shown). 
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The following screen capture shows the General tab of the newly created SP-General Server 

Interworking Profile. 
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The following screen capture shows the Advanced tab of the newly created SP-General Server 

Interworking Profile. 
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7.4.3. SIP Server Configuration 

SIP Server Profiles should be created for the Avaya SBC’s two peers, the Call Server (IP Office) 

and the Trunk Server or SIP Proxy at the service provider’s network. 

 

To add the SIP Server profile for the Call Server, from the Services menu on the left-hand 

navigation pane, select SIP Servers (not shown). Click Add (not shown) and enter the profile 

name: IP Office-Thornton. 

• Click Next. 

 

 
 

On the Edit SIP Server Profile – General window:   

• Server Type: Select Call Server. 

• IP Address / FQDN: 10.64.101.127 (IP Address of IP Office). 

• Port: 5061 (This port must match the port number defined in Section 5.2.1).  

• Transport: Select TLS. 

• Select a TLS Client Profile (Section 7.3.3). 

• Click Next (not shown).  
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• Click Next until the Add SIP Server Profile - Advanced tab is reached (not shown). 

• On the Add SIP Server Profile - Advanced tab: 

• Verify that Enable Grooming is checked (required for TLS transport). 

• Select Avaya-IPO from the Interworking Profile drop down menu (Section 7.4.1). 

• Leave the Signaling Manipulation Script at the default None. 

• Click Finish.  
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The following screen capture shows the General tab of the newly created IP Office-Thornton 

SIP Server Configuration Profile. 

 

 
 

The following screen capture shows the Advanced tab of the newly created IP Office-Thornton 

SIP Server Configuration Profile. 
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To add the SIP Server profile for the Trunk Server, from the Services menu on the left-hand 

navigation pane, select SIP Servers (not shown). Click Add (not shown) and enter the profile 

name: Service Provider. 

• Click Next. 

 

 
 

On the Edit SIP Server Profile – General window:   

• Server Type: Select Trunk Server.  

• Click on Add and under IP Address / FQDN enter: 192.168.96.97 (WorldNet SIP proxy 

server IP address, this information was provided by WorldNet). 

• Enter 5060 under Port and select UDP for Transport. 

• Click Next (not shown). 
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On the Add SIP Server Profile - Authentication tab: 

• Check the Enable Authentication box.  

• Enter the User Name credential provided by WorldNet for SIP trunk registration. 

• Leave Realm blank.  

• Enter Password credential provided by WorldNet for SIP trunk registration.  

• Click Next. 

 

 
 

• Click Next on the Add Server Configuration Profile - Heartbeat window (not shown). 
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On the Add SIP Server Profile - Registration tab. 

• Check the Register with All Servers box. 

• Frequency: Enter the amount of time (in seconds) between REGISTER messages that 

will be sent from the enterprise to the Service Provider Proxy Server to refresh the 

registration binding of the SIP trunk. This value should be chosen in consultation with the 

service provider. 120 seconds was the value used during the compliance test. 

• The From URI and To URI entries for the REGISTER messages are built using the 

following:  

- From URI: Use the Avaya SBC public IP address and the enterprise domain 

(10.10.80.51@devconnect.com), as shown on the screen below. 

- To URI: Use WorldNet’s SIP proxy IP address (192.168.96.97@(192.168.96.97), as 

shown on the screen below. 

- Click Next. 

 

 
 

• Click Next on the Add SIP Server Profile - Ping window (not shown). 
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On the Add SIP Server Profile – Advanced tab:  

• Uncheck Enable Grooming (not required for UDP transport).  

• Select SP-General from the Interworking Profile drop-down menu (Section 7.4.2). 

• Click Finish. 
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The following screen capture shows the General tab of the newly created Service Provider SIP 

Server Configuration Profile. 
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The following screen capture shows the Authentication tab of the newly created Service 

Provider Server Configuration Profile. 

 

 
 

The following screen capture shows the Registration tab of the newly created Service Provider 

Server Configuration Profile. 
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The following screen capture shows the Advanced tab of the newly created Service Provider 

SIP Server Configuration Profile. 
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7.4.4. Routing Profiles 

Routing profiles define a specific set of routing criteria that are used, in conjunction with other 

types of domain policies, to determine the route that SIP packets should follow to arrive at their 

intended destination. 

 

Two Routing profiles were created, one for inbound calls, with IP Office as the destination, and 

the second one for outbound calls, which are sent to the Service Provider SIP trunk. 

 

To create the inbound route, from the Configuration Profiles menu on the left-hand side (not 

shown):  

• Select Routing (not shown).  

• Click Add in the Routing Profiles section (not shown).  

• Enter Profile Name: Route_to_IPO_TLS. 

• Click Next.  
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On the Routing Profile screen complete the following: 

• Click on the Add button to add a Next-Hop Address. 

• Priority / Weight: 1 

• SIP Server Profile: Select IP Office Thornton. 

• Next Hop Address is populated automatically with 10.64.101.127:5061 (TLS) (IP 

Office IP address, Port and Transport).  

• Click Finish. 

 

 
 



 
HG; Reviewed: 

SPOC 10/6/2024 

Avaya DevConnect Application Notes 

©2024 Avaya Inc. All Rights Reserved. 

77 of 118 

WN-IPO120SBC102 

 

The following screen shows the newly created Route_to_IPO_TLS Routing Profile. 

 

 
 

Similarly, for the outbound route: 

• Select Routing (not shown).  

• Click Add in the Routing Profiles section (not shown).  

• Enter Profile Name: Route to SP. 

• Click Next.  
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On the Routing Profile screen complete the following: 

• Load Balancing: Select Priority. 

• Click on the Add button to add a Next-Hop Address. 

• SIP Server Profile: Select Service Provider. 

• The Next Hop Address is populated automatically with 192.168.96.97:5060 (UDP) 

(WorldNet’s SIP Proxy IP address, port and transport).  

• Click Finish. 
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The following screen capture shows the newly created Route to SP Routing Profile. 
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7.4.5. Topology Hiding 

Topology Hiding is a security feature which allows changing several parameters of the SIP 

packets, preventing private enterprise network information from being propagated to the 

untrusted public network.  

 

Topology Hiding can also be used as an interoperability tool to adapt the host portion in SIP 

headers like To, From, Request-URI, Via, Record-Route and SDP to the IP addresses or domains 

expected by IP Office and the SIP trunk service provider, allowing the call to be accepted in each 

case.  

 

For the compliance test, only the minimum configuration required to achieve interoperability on 

the SIP trunk was performed. Additional steps can be taken in this section to further mask the 

information that is sent from the Enterprise to the public network. 

 

To add the Topology Hiding Profile in the Enterprise direction, select Topology Hiding from the 

Configuration Profiles menu on the left-hand side (not shown): 

• Click on default profile and select Clone Profile (not shown). 

• Enter the Profile Name: IP Office. 

• Click Finish (not shown). 
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The following screen capture shows the newly added IP Office Topology Hiding Profile. Note 

that for IP Office no values were overwritten (left with default values). 
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To add the Topology Hiding Profile in the Service Provider direction, select Topology Hiding 

from the Configuration Profiles menu on the left-hand side (not shown): 

• Click on default profile and select Clone Profile (not shown). 

• Enter the Profile Name: Service_Provider. 

• Click Finish (not shown). 
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The following screen capture shows the newly added Service_Provider Topology Hiding 

Profile (left with default values). 
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7.5. Domain Policies 

Domain Policies allow configuring, managing and applying various sets of rules designed to 

control and normalize the behavior of call flows, based upon various criteria of communication 

sessions originating from or terminating in the enterprise. 

7.5.1. Application Rules  

Application Rules defines which types of SIP-based Unified Communications (UC) applications 

the Avaya SBC will protect: voice, video, and/or Instant Messaging (IM). In addition, 

Application Rules defines the maximum number of concurrent voice and video sessions the 

network will process in order to prevent resource exhaustion.  

 

From the menu on the left-hand side, select Domain Policies → Application Rules (not shown).  

• Click on the Add button to add a new rule (not shown). 

• Rule Name: enter the name of the profile, e.g., 500 Session. 

• Click Next.  
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• Under Audio check In and Out and set the Maximum Concurrent Sessions and 

Maximum Sessions Per Endpoint to recommended values; the value of 500 was used in 

the sample configuration. 

• Under Video check In and Out and set the Maximum Concurrent Sessions and 

Maximum Sessions Per Endpoint to recommended values; the value of 100 was used in 

the sample configuration. 

• Click Finish.  
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The following screen capture shows the newly created 500 Sessions Application Rule. 

 

 

7.5.2. Media Rules 

Media Rules allow one to define RTP media packet parameters such as prioritizing encryption 

techniques and packet encryption techniques. Together these media-related parameters define a 

strict profile that is associated with other SIP-specific policies to determine how media packets 

matching these criteria will be handled by the Avaya SBC security product. For the compliance 

test one media rule was created toward IP Office, the existing default-low-med media rule was 

used toward the Service Provider. 

  

To add a media rule in the IP Office direction, from the menu on the left-hand side, select 

Domain Policies → Media Rules.  

• Click on the Add button to add a new media rule (not shown). 

• Under Rule Name enter IPO_SRTP. 

• Click Next. 
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• Under Audio Encryption, Preferred Format #1, select 

SRTP_AES_CM_128_HMAC_SHA1_80. 

• Under Audio Encryption, Preferred Format #2, select RTP. 

• Under Audio Encryption, uncheck Encrypted RTCP. 

• Under Audio Encryption, check Interworking. 

• Repeat the above steps under Video Encryption. 

• Under Miscellaneous check Capability Negotiation. 

• Click Next (not shown). 

 

 
 

• Accept default values in the remaining sections by clicking Next (not shown), and then 

click Finish (not shown). 
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For the compliance test, the default-low-med Media Rule was used in the Service Provider 

direction.  
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The following screen capture shows the newly created IPO_SRTP Media Rule. 
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The following screen capture shows the default-low-med Media Rule. 
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7.5.3. End Point Policy Groups 

End Point Policy Groups are associations of different sets of rules (Media, Signaling, Security, 

etc.) to be applied to specific SIP messages traversing through the Avaya SBC. 

 

To create an End Point Policy Group for the Enterprise, from the Domain Policies menu, select 

End Point Policy Groups (not shown).  

• Click on the Add button to add a new policy group (not shown). 

• Group Name: Enterprise. 

• Click Next. 

 

 
 

• Application Rule: 500 Sessions.  

• Border Rule: default.  

• Media Rule: IPO_SRTP (Section 7.5.2).  

• Security Rule: default-low.  

• Signaling Rule: default. 

• Click Finish. 
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The following screen capture shows the newly created Enterprise End Point Policy Group. 
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Similarly, to create an End Point Policy Group for the Service Provider SIP Trunk. 

• Click on the Add button to add a new policy group (not shown). 

• Group Name: Service Provider. 

• Click Next. 

 

 
 

• Application Rule: 500 Sessions 

• Border Rule: default.  

• Media Rule: default-low-med.  

• Security Rule: default-low.  

• Signaling Rule: default. 

• Click Finish. 
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The following screen capture shows the newly created Service Provider End Point Policy 

Group. 
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7.6. Network & Flows Settings 

The Network & Flows settings allow the management of various device-specific parameters, 

which determine how a particular device will function when deployed in the network. Specific 

server parameters, like network and interface settings, as well as call flows, etc. are defined here.  

7.6.1. Network Management 

The network information should have been previously completed. To verify the network 

configuration, from the Network & Flows on the left-hand side, select Network Management. 

Select the Networks tab. 

 

In the event that changes need to be made to the network configuration information, they can be 

entered here.  

 

Use Figure 1 as reference for IP address assignments. 

 

Note: Only the highlighted entity items were created for the compliance test and are the ones 

relevant to these Application Notes. Blurred out items are part of the Remote Worker 

configuration, which is not discussed in these Application Notes. 
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On the Interfaces tab, click the Status control for interfaces A1 and B1 to change the status to 

Enabled. It should be noted that the default state for all interfaces is Disabled, so it is important 

to perform this step, or the Avaya SBC will not be able to communicate on any of its interfaces. 
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7.6.2. Media Interface 

Media Interfaces are created to specify the IP address and port range in which the Avaya SBC 

will accept media streams on each interface. Packets leaving the interfaces of the Avaya SBC 

will advertise this IP address, and one of the ports in this range as the listening IP address and 

port in which the SBC will accept media from the connected server. Create a SIP Media 

Interface for both the inside and outside IP interfaces. On the Private and Public interfaces of the 

Avaya SBC, the port range 35000 to 40000 was used. 

 

From the Network & Flows menu on the left-hand side, select Media Interface (not shown). 

• Select Add in the Media Interface area (not shown).  

• Name: Private_med. 

• Under IP Address select: Network_A1 (A1, VLAN 0) 

• Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBC, toward IP 

Office).  

• Port Range: 35000-40000. 

• Click Finish. 
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Select Add in the Media Interface area (not shown).  

• Name: Public_med. 

• Under IP Address select: Network_B1 (B1, VLAN 0) 

• Select IP Address: 10.10.80.51 (Outside IP Address of the Avaya SBC, toward the 

Service Provider). 

• Port Range: 35000-40000. 

• Click Finish. 

 

 
 

The following screen capture shows the newly created Media Interfaces. 
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7.6.3. Signaling Interface 

To create the Signaling Interface toward IP Office, from the Network & Flows menu on the left-

hand side, select Signaling Interface (not shown). 

• Select Add in the Signaling Interface area (not shown). 

• Name: Private_sig. 

• Under IP Address select: Network_A1 (A1, VLAN 0)  

• Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBC, toward IP 

Office). 

• TLS Port: 5061.  

• Select a TLS Profile (Section 7.3.2). 

• Click Finish. 

 

 
 



 
HG; Reviewed: 

SPOC 10/6/2024 

Avaya DevConnect Application Notes 

©2024 Avaya Inc. All Rights Reserved. 

100 of 118 

WN-IPO120SBC102 

 

• Select Add in the Signaling Interface area (not shown). 

• Name: Public_sig. 

• Under IP Address select: Network_B1 (B1, VLAN 0)  

• Select IP Address: 10.10.80.51 (outside or public IP Address of the Avaya SBC, toward 

the Service Provider). 

• UDP Port: 5060.  

• Click Finish. 
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The following screen capture shows the newly created Signaling Interfaces. 
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7.6.4. End Point Flows 

When a packet is received by Avaya SBC, the content of the packet (IP addresses, URIs, etc.) is 

used to determine which flow it matches. Once the flow is determined, the flow points to a 

policy group which contains several rules concerning processing, privileges, authentication, 

routing, etc. Once routing is applied and the destination endpoint is determined, the policies for 

this destination endpoint are applied. The context is maintained, so as to be applied to future 

packets in the same flow. The following screen illustrates the flow through the Avaya SBC to 

secure a SIP Trunk call. 
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The End-Point Flows define certain parameters that pertain to the signaling and media portions 

of a call, whether it originates from within the enterprise or outside of the enterprise. 

 

To create the call flow toward the Service Provider SIP trunk, from the Network & Flows menu, 

select End Point Flows (not shown), then the Server Flows tab. Click Add (not shown). 

• Name: SP to IPO Flow 

• Server Configuration: Service Provider (Section 7.4.3). 

• URI Group: *  

• Transport: *  

• Remote Subnet: *  

• Received Interface: Private_sig (Section 7.6.3). 

• Signaling Interface: Public_sig (Section 7.6.3).  

• Media Interface: Public_med (Section 7.6.2). 

• Secondary Media Interface: None. 

• End Point Policy Group: Service Provider (Section 7.5.3). 

• Routing Profile: Route_to_IPO_TLS (Section 7.4.4). 

• Topology Hiding Profile: Service_Provider (Section 7.4.5). 

• Check Link Monitoring from Peer. 

• Click Finish. 

 

Note – Ensure “Link Monitor from Peer” is checked. Selecting Link Monitoring from 

Peer enables Avaya SBC to send a 200 OK response for a match of the SIP OPTIONS request 

with a server flow. If you don’t enable Link Monitoring from Peer, then OPTIONS request 

will be relayed to the destination server (IP Office). 
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To create the call flow toward IP Office, click Add (not shown). 

• Name: IPO to SP Flow. 

• Server Configuration: IP Office-Thornton (Section 7.4.3). 

• URI Group: *  

• Transport: *  

• Remote Subnet: *  

• Received Interface: Public_sig (Section 7.6.3). 

• Signaling Interface: Private_sig (Section 7.6.3). 

• Media Interface: Private_med (Section 7.6.2). 

• Secondary Media Interface: None. 

• End Point Policy Group: Enterprise (Section 7.5.3). 

• Routing Profile: Route to SP (Section 7.4.4). 

• Topology Hiding Profile: IP Office (Section 7.4.5). 

• Click Finish. 
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The following screen capture shows the newly created End Point Flows. 
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8. WorldNet Telecommunications SIP Trunking Service 
Configuration 

To use WorldNet Telecommunications SIP Trunking Service, a customer must request the 

service from WorldNet Telecommunications using the established sales processes. The process 

can be started by contacting WorldNet Telecommunications via the corporate web site at: 

https://www.worldnetpr.com/en/voice-service/ and requesting information. 

 

During the signup process, WorldNet Telecommunications and the customer will discuss details 

about the preferred method to be used to connect the customer’s enterprise network to WorldNet 

Telecommunications network. 

 

WorldNet Telecommunications is responsible for the configuration of WorldNet 

Telecommunications SIP Trunking Service. The customer will need to provide the public IP 

address used to reach the Avaya Session Border Controller at the enterprise, the public IP 

address assigned to interface B1. 

 

WorldNet Telecommunications will provide the customer the necessary information to configure 

Avaya IP Office and the Avaya Session Border Controller following the steps discussed in the 

previous sections, including: 

 

WorldNet Telecommunications will provide the following information: 

• SIP Trunk registration credentials (User Name, Password, etc.). 

• WorldNet’s SIP Proxy IP address. 

• Supported audio codecs and their prefer order. 

• DID numbers, etc. 

https://www.worldnetpr.com/en/voice-service/
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9. Verification Steps 
This section provides verification steps that may be performed to verify that the solution is 

configured properly. 

 

The following steps may be used to verify the configuration: 

• Verify that endpoints at the enterprise site can place calls to the PSTN. 

• Verify that endpoints at the enterprise site can receive calls from the PSTN. 

• Verify that users at the PSTN can end active calls to endpoints at the enterprise by 

hanging up. 

• Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up. 

9.1. IP Office System Status 

The following steps can also be used to verify the configuration. 

 

Use the IP Office System Status application to verify the state of SIP connections. Launch the 

application from Start → Programs → IP Office → System Status on the PC where IP Office 

Manager is installed, log in with the proper credentials. 
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify 

the Current State is Idle for each channel. 
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9.2. Monitor 

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling 

messaging on the SIP trunk. Launch the application from Start → Programs → IP Office → 

Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the 

taskbar and Select the IP address of the IP Office system under verification.  

 

 
 

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the 

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the 

color used to represent the packets in the trace can be customized by right clicking on the type of 

packet and selecting the desired color. 
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9.3. Avaya Session Border Controller 

There are several links and menus located on the taskbar at the top of the screen of the web 

interface that can provide useful diagnostic or troubleshooting information. 
 

Alarms: Provides information about the health of the Avaya SBC. 

 

 
 

The following screen shows the Alarm Viewer page. 
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Incidents: Provides detailed reports of anomalies, errors, policies violations, etc. 
 

 
 

The following screen shows the Incident Viewer page. 
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Status: Provides the status for each server handling calls to/from the PSTN. 
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Diagnostics: This screen provides a variety of tools to test and troubleshoot the Avaya SBC 

network connectivity. 
 

 
 

The following screen shows the Diagnostics page with the results of a ping test. 
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Additionally, the Avaya SBC contains an internal packet capture tool that allows the capture of 

packets on any of its interfaces, saving them as pcap files. Navigate to Monitor & Logging → 

→ Trace. Select the Packet Capture tab, set the desired configuration for the trace and click 

Start Capture. 
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Once the capture is stopped, click on the Captures tab and select the proper pcap file. Note that 

the date and time is appended to the filename specified previously. The file can now be saved to 

the local PC, where it can be opened with an application such as Wireshark. 

 

 
 

Also, the traceSBC tool can be used to monitor the SIP signaling messages between the Service 

provider and the Avaya SBC. 
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10. Conclusion 
These Application Notes describe the procedures required to configure Avaya IP Office Release 

12.0 and Avaya Session Border Controller Release 10.2 to connect to WorldNet 

Telecommunications SIP Trunking Service. WorldNet Telecommunications SIP Trunking 

Service is a SIP-based Voice over IP solution for customers ranging from small businesses to 

large enterprises. It provides a flexible, cost-saving alternative to traditional hardwired telephony 

trunks.  

 

Interoperability testing was completed successfully with the observations/limitations outlined in 

the scope of testing in Section 2.1 as well as under test results in Section 2.2. 

11. Additional References  
This section references the documentation relevant to these Application Notes. Product 

documentation for Avaya IP Office, including the following, is available at: 

http://support.avaya.com/ 

 

[1] Deploying IP Office Server Edition and Application Servers, Release 12.0, Issue 31, April 

2024 

[2] IP Office Platform 12.0, Deploying Avaya IP Office Servers as Virtual Machines, June 2024 

[3] Avaya IP Office Platform Server Edition Reference Configuration Release 12.0, Issue 22, 

May 2024 

[4] IP Office Platform 12.0, Deploying an IP500 V2 IP Office Basic Edition System, Issue 41e, 

May 29, 2024 

[5] IP Office Platform 12.0, Deploying an IP500 V2 IP Office Essential Edition System, Issue 

41e, May 29, 2024 

[6] Administering Avaya IP Office using Manager, Release 12.0, Issue 51.1.2, June 2024. 

[7] Administering Avaya IP Office with Web Manager, Release 12.0, Issue 46.1.1, May 2024. 

[8] Avaya IP Office Platform Feature Description, Release 12.0, Issue 21.1.1, May 2024. 

[9] Planning for and Administering Avaya Workplace Client for Android, iOS, Mac and 

Windows, September 2020 

[10] Deploying Avaya Session Border Controller on a Virtualized Environment Platform, Release 

10.2, Issue 1, March 2024. 

 

http://support.avaya.com/
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